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Moodie Introduction 

Moodie is a Course Management System (CMS), also known as a Learning Management System 
(LMS) or a Virtual Learning Environment (VLE). It is a Free web application that educators can 
use to create effective online learning sites. 

The word Moodie was originally an acronym for Modular Object-Oriented Dynamic Learning 
Environment, which is mostly useful to programmers and education theorists. It's also a verb that 
describes the process of lazily meandering through something, doing things as it occurs to you to 
do them, an enjoyable tinkering that often leads to insight and creativity. As such it applies both 
to the way Moodie was developed, and to the way a student or teacher might approach studying 
or teaching an online course. Anyone who uses Moodle is a Moodler. 

Moodle.org is our community site where Moodle is made and discussed. Please use the menus to 
explore and join in! (http://docs.moodlc.org/20/en/About Moodle) 

Site Ad rn in I ntrod uct ion 

Moodie 2.1 + is flexible and allows you to change any settings you make at any time. Some 
settings are best set prior to adding courses or participants to your site. For example, user 
defaults, security settings, and advanced features should be explored prior to course 
implementation. None of the settings are permanent, nor are they required. As you explore how 
the settings affect your server and user options, you are free to adapt and modify settings at any 
time. 
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Notiti ( atio n s 

This is where you can go to check the version of Moodie you are running and when your most 
previous build took place. 

Osers 

Upload Users 
There are a variety of ways to add users to your Moodie. 

1. Site admin >Users> Accounts> Add a new user (or) Upload users 
a. Add a new user is a manual addition 
b. Upload users is through a CSV file 

2. To learn details for uploading a proper CSV file go to: 
http://docs.moodle.org/20/en/adminluploaduser 

Bulk User Actions 

This feature allows admins to select users by creating filters based on the needs of the admin. 
Options include 

• Deleting user accounts 
• Display users with common characteristics/roles 
• Download user data in text, ODS, or Excel format 
• Force users to change passwords 

Roles in Mnodle 

There are several roles in Moodie other than the Site Administrator. This allows the wealth of 
management to be shared but at limited roles so that high level actions can only be changed by 
the site admin. 
To get to the roles: 

1. Site admin >Users> Permissions> Define roles 
2. Click the role you would like to study or edit 

a. If you are going to edit a role, it is best to copy that role, rename it and change 
only the copy. 

b. That way you have the original intact in the event that the changes don't work as 
expected and need to be reverted 

3. If you'd like to add a role, click Add a role, name it, set the parameters you want that role 
to fulfill 

4. For more about roles: http://docs.moodle.org/20/en/Roles 2.0 
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Language Settings 

Moodie 2 supports 89 standard world languages. Moodie is written in international English and 
is the default language upon installation. Best practice dictates loading the regional language 
packs where they are available. 

The Moodie Admin has control over the availability of language packs that are loaded on the 
server and available for teacher use in courses, as well as setting the default language. 
Additionally, the language pack is a user preference that can be changed in the individual profile. 
Participants will need to choose their language in their profile so their language of choice is 
selected. 

Setting your language before you delve into the other settings will allow you to configure your 
server to match your needs. 

1. Import Language Packs 
a. Login to your Moodie as Site Admin 
b. Click Settings > Language > Language packs 
c. Select the desired language pack in the column on the right 
d. Click the 'Install selected language pack' button 

-- Site administration 

@ Notifications 

[ill. Registration 

@_Advanced features 

t· Users 

~ Co urses 

~ Grades 

~ Location 
·.- Language 

[ill Language settings 

1m Language packs 
[ill Language 

customization 

~ Plugins 

~ Security 

~ Appearance 

~ Front page 

~ Server 

~ Reports 

~ Development 

[]_Question engine 
upgrade helper 

Installed language packs 
English· United States (en_us) 
English (en) 
Espanol· Argentina (es_ar) 
Espanol - Espana (es_es) 
Espanol - lnternacional (es) 
Espanol- Mexico (es_mx) 
Franr,;:ais (fr) 

@ninstall selected language pack I 

I Upda1e all installed language packs I 

2. Setting the Site Default Language 
a. Click Settings> Language> Language settings 
b. Locate the 'Default Language' setting 

List of available languages 
Afrikaans (af) -----:j 
.h9c:;:;: (am) ~-· :1 

~~ (ar) ,. _ '· 

1
Asturianu (as!) == !l 
Azarbaycanca (az) I : 
5enapycKaR (be) ·-! 
obnrapcKH (bg) ! 
'ff(Off (bn) 
Bosanski (bs) 
catala (ca) 
~1.»- (ckb) 
Cestina (cs) 
Cymraeg (cy) 
Dansk (da) 
Deutsch (de) 
Deutsch- Du (de_du) 
Deutsch· Kids (de_ki ds) 

-1;.1'} (dv) 
EMI']VIKa (el) 
English- Kids (en_kids) 
English· United States (en_ us) ~ I 

[ Install selected language pack J 
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c. Select the desired language pack from the drop down list 
• Sill!:.-a--,dm-ln-ls~--:au--:.on 

lli!NoMcaoons Language autodetetl .t . . , 
@lRe~,s~ation Detect defautt langu; ge from browser setting, W disabled sne delaun is used. 
@lAdvancedfeatures 

~users ~ 
~ Courses Defaun language English-UnliedSiates(en_us) • • • . . . • m· .'"' 
f Grades 
~ Location Choose a default language fortl1e whole site. Users can overnde this setting using the language menu or the setting In their personal profile. 

~ Language 
ffi'l Language set1ings 
ffi'l Language packs 
ffi'l language 

cuslomlzatlon 

Display language menu 
t.~ - .,, 

Keep in mind 

Choose wllether or not you want to display the general-purpose language menu on the home page, login page etc. This does nat a1fect the user 
language in their own prom e. 

• Language packs can be forced in a course or can be set to be selected by user 
o Foreign language instructors may want to force the language 

• Language packs do not translate words entered into Moodie. Only core Moodie pieces are 
translated on all Moodie pages. 

• Explore the various language options on your profile 

-



Tirne Zone and Loratinn Settin~s 

Moodie supports all world time zones in the default time zone as well as in UTC (Universal 
Time Codes) if you'd like. The advantage to using UTC is that they include daylight saving time 
rules. 

Setting the time zone is important in Moodie as teachers set due dates and activity opening and 
closing times, therefore it is a significant setting to establish. An example is if a teacher sets an 
activity to open at a certain time, the server will use the teacher' s time zone to set the time. Then, 
it will adjust the time displayed for each participant based on their selected time zone. 

Setup 

Let's review your server's time zone 

1. Navigate to your Settings >Location> Update time zones 
2. Click continue 

a. This will update the Region/city codes on your server. 

Location settings 

1. Navigate to your Site admin > Location > Location settings 
2. Adjust your default time zone settings 
3. Selecting a time zone in the forced area will force all users to the default standard time 

zone you selected 
4. Select your default country 
5. Type in your default city if you'd like 
6. Scroll to the bottom of the page and click the save changes button 

a. You will know you have been successful when you see the "Changes saved" 
message at the top of the page 
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SilP PolidPs 

This area of Moodie allows you to set policies site wide that impact all users. 

Setting your sight policies 

1. Go to Site Administration > Security > Site policies 
2. Select the settings that you want for your organization 
3. Be sure to select your settings before you set up user accounts so all users are affected 

Here are some user accounts setting details to consider 

Option 
, . 

Protect usernames 

Force users to log in 
Force users log in for profiles 

Open to Google 

Profile visible roles 

Maximum uploaded file size 

User quota 

Maximum time to edit posts 

Allow extended characters in username 

Site policy URL 

Site policy URL for guests 

Password policy 

Function 
-

Prevents any hints to lead user to guessing of 
username or email address 
Forces log in before users see Moodie home 
Requires all users to log in before seeing any 
user profiles 
Do you want Google to be able to access your 
Moodie? 
Determine who is able to see the profiles of 
other participants or course members 
This sets the maximum file size allowable for 
upload and can be adjusted at the course and 
activity level 
This setting sets the maximum allowable size 
for their personal file repository 
This setting does not affect teachers or 
administrators 
Enable this option if you are using email 
addresses as usernames 
Upon first time log in users are required to 
agree to your user agreement 
You may set an agreement for guests who 
access your site 
Activating these elements will set specified 
restrictions for password policies. This setting 
will not affect passwords assigned via the bulk 
user upload process_ 
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front Page Setting~ 

These settings allow you to determine what is shown on the front page to normal users. 
To access your front page settings 

Site administration > Front page > Front page settings 

Here are front page setting details to consider 
Option 
Full site name 

Short name for site 

Front page description 

Front page and Front page items when 
logged in 

Include a topic section 

News items to show 

Function 
This sets the site name that is shown in the top 
banner of some themes. It is best practice to 
assign your site a name 
This short name needs to be written as all one 
word, no spaces. It will be displayed as the first 
breadcrumb in the navigation crumb trail. 
Clicking this short name will return 
participants to the Moodie home page 
This is what shows in your Course/site 
Description block 
Select your choices from the drop down menu. 
Explore and experiment with this to determine 
what you like 
This option allows you to place content and 
information on your front page for access after 
users log in. To access and edit this area, you 
must activate your editing on the front page. If 
no content is in this section, it will not be 
visible to users. 
If you are using the Latest news on your front 
page, select the number of items you would 
like visible to logged in users 

Be sure to click the Save changes button to activate your choices. 
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Site ThPnlPS 

Theme selector 

Moodie has pre-installed themes for users . Themes are set with their own settings for each, 
therefore, exploring and experimenting with theme choices will demonstrate the differences and 
the styles within each. 

To select a theme: 
1. Site administration > Appearance >Themes >Theme selector 
2. Look over the themes and select 'Use for modem browsers' to changes your default site 

theme 
a. Use for modem browsers will ascertain that your Moodie will work in Safari, 

Chrome, etc. 
3. To customize the themes for your site click 

a. Site administration> Appearance> Themes> select the theme you would like to 
customize 

Theme Settings 

This area of the Site admin allows you to set site wide options for the theme functions. There are 
a variety of options you can set from the site level to the user level. 
Option Function 
Allow user themes This will allow each user to select their own 

Allow course themes 

Allow category themes 
Allow users to hide blocks 

theme for Moodle, but does not override 
course themes set by instructors 
This allows instructors the flexibility to select a 
theme for their own course 
This allows themes to set for each category 
This is a very nice feature that allows users to 
customize the look and feel of their own 
Moodie to match their learning and processing 
needs 

Allow blocks to use the dock Another very nice feature for users to 
customize the look and feel of their Moodle 

Be sure to click the Save changes button at the bottom of the page to activate your selections. 
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Achninistrator A(TOunt Settings 

You have much flexibility with your administrator accounts in Moodie. There are now a variety 
of Administrator Roles you can assign so that not all elements are accessible to all admin roles. 
For security and regulation reasons it is best to limit the number of administrators on your 
Moodie site to as few people as needed. 

Adding a new user to Moodie 

1. Site admin >Users> Accounts> Add a new user 
2. Complete the required fields 

a. Using changeme or change.me will force a password change upon first time log in 
for all users with that password 

3. Click the Update profile button to save changes and add the user to Moodie 

Assigning roles in Moodie 

1. Site admin >Users> Permissions> Site administrators 
2. Select the name of the user you want to add as admin and click the add button to grant 

them Site admin rights 
3. Confirm that you want to add this user by clicking the Continue button 

Understanding Moodie's Advaru·ed Featur£~s 

Moodie's "Advanced features" include new features that affect course development and 
functions. This is where you can activate/deactivate site wide features. 

1. Site admin > Advanced settings 
2. Browse the options and enable/disable the features as needed for optimal course functions 

for your organization 
3. As you explore Moodie and use the variety of features, you may come back and change 

them as needed at any time 
a. Remember the changes are site wide and will affect all courses 

4. Click the Save changes button to assure your changes are completed 

For details on the Advanced features check here: 
http://docs .moodle.org/20/en/adminlsetting/optionalsubsystems 
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Sit«.- l{('gastration 

Registering your Moodie with the Moodle.org community hub (known as MOOCH) will set you 
to receive notifications of security fixes and new releases. This is not a required action, however, 
it will keep you informed and you have the option to keep your site private or make it public. 

Set up your registration 

1. Site admin > Registration 
2. Register with Moodle.org (MOOCH) 
3. Complete the registration page with your information 
4. Click the Register button at the bottom of the page 

Plugins: Filter~ 

The filters in Moodie allow users to handle different types of multimedia files within Moodie. 
To activate the filters : 

1. Site admin > Plugins > Filters > Manage filters 
2. Locate the Multimedia plugins 
3. Check the box next to the plugins you would like activated 
4 . Click the Save changes button at the bottom of the page to activate your selections 
5. For more information on the filters 

hlt p: I I docs. moodle. org/20/ en/ admin/ setti ng/fil tersettingfil termed ia p 1 ugin 

Opening/Closing Your SJlc 

Setting your server for maintenance mode 

There will be times you want your server to be free of users, whether for updates or maintenance. 
You can set your site so that no one but admins can log in. 
To set maintenance mode: 

1. Site admin >Server> Maintenance mode 
2. Enable from the Maintenance mode drop down 
3. Create a message to let users know when the site is expected to be running again for 

general use 
4 . Once you have completed your maintenance you will need to reset your mode to Disable 

so all users can access and use the site 
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Force Log Ins 

Enable this feature so only users with passwords and log ins can access your site and courses. 
To force log in: 

1. Site admin > Security> Site policies 
2. Locate the option Force users to log in 
3. Click the check box to add a checkmark to enable this feature 
4. Click the save changes button at the bottom of the page 

Create a custom message (optional) 

If you 'd like to create a custom message for users to see on the log in page, use the log in 
instructions block. The block does not show or activate until there is content to display. 
To create a custom message: 

1. Site admin > Plugins >Authentication> Manage authentication 
2. Scroll to the Manage authentication page until you see the 'instructions' edit box 
3. Type in your custom message 
4. While you are here you can also choose to remove the Guest log in button 

a. This is helpful if you do not encourage or allow guests in the site 
b. Locate the settings for the Guest log in button and select 'Hide' from the options 

5. Click the save changes button to activate your desired changes 

Courses 

Course default settings 
You have several options when it comes to adding courses to your Moodie. You can create 
individual courses or you can have teachers request a course through Moodie. Regardless of 
which method you choose, it is best to set your course default settings at the admin level. 
To set Course default settings: 

1. Site admin > Courses > Course default settings 
2. Select the elements you want for the course defaults for each new course 
3. Click the save changes button at the bottom of the page to activate your changes 

Course request settings 
If you'd like your teachers to be able to request a course through Moodle, set your course request 
in the site admin settings. 
To set Course request: 

1. Site admin >Courses> Course request 
2. Check the Enable course requests box 
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3. Select the category where you would like all new courses to go upon acceptance 
a. The category can be changed later if you'd like 

4. Select the name of the admin who will receive the course request notification 
a. That person will go into Moodle and accept or reject the course request 

5. Click the save changes button at the bottom of the page 

Courses pending approval 

To see and access pending requests: 
1. Site admin > Courses > Pending requests 
2. To the right of each request will be an Accept or Reject button 
3. Press the accept button and the user will get an email notifying them of acceptance and 

they will be able to access their course and start building 
4. Press the reject button and a field will come up for you to type a message to the requester 

notifying them that their request was rejected and why 
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Your Moodie Site Oocurnentation 

Notifications 
Moodie version 

Latest build 

Regist ration 
Did you register with Mooch? 

1 Did you register with any hubs? 

I 

~ Which hub? 

I 

Advanced Features 
I Feature 

Enable outcomes 
Enable comments 

· Enable tags functionality 
1 Enable notes 
: Enable portfolios 

Enable web services 
1 Enable messaging system 
1 Hide read notifications 

1 Delete read notifications 
; Enable statistics 
I 

Enable RSS feeds 

Default 

No 
' Yes 

Yes 
, Yes 

No 
1 No 

Yes 
' No 

1 week 
·] No 

No 

-

: Blog visibility All site users can see all blog 
I · entries 
I - - . 
' Networking No -
I Enable conditional access . No 
Enable plagiarism plugins No 

. Setting 

-r 

I 
..-

- .-
I 

1 
j _ 

. -
I 
.!. 

!-
I 

_.L. 
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Accounts> User profile fields 
List any custom profile fields added to your site 
Category , Short Name Type 

t· -
t 

Accounts> Cohorts 
Explain how you may use cohorts on your site 

-- -- -----~ 

Permissions> User policies 

I Feature I Default ; Setting 
Role for visitors 

Role for guests 

Default role for all users 

Guest 

Guest 

Authenticated user 

Creator's role in new course Teacher 

Auto-login guests No 

, Hide user fields None 

When selecting users, search Email address 
I and display 

-i 

Have you created any special roles on your site? 
1 Role ___ .I Special abilities 
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On the Add/edit courses screen you can create course categories and assign roles, cohorts, and 
themes, to categories 

Record your categories here 

1 Category : Subcategory I Assigned role [ Assigned cohort 
l 

.L 
I 

, Theme 

.. 
j 

i 
-j 

-1 - -! ·- ---

Course default settings 

Feature Default . Setting ------
. Format Weekly 
l 
. Max number for I 52 
I weeks/topics ~ j 
: Number of weeks/topics • 10 _ . __ 

: Hidden sections Shown in collapsed form J . 

, News items to show _ 5 J. 

' Show grade book to students j Yes f 
: Sh~w activity reports . f No 

~ Max upload size 
; Group mode - J No-groups r-- -

i No ~ --· -~- . L----· 
; Force 

l Visible 

-
· Force language 

: Completion tracking 

This course is available to 
I students 
: Do not force 

--- -! 
Disabled 

I Completion tracking begins , No 
' on enrollment I 

Course request 
! Feature l Default 
I -

j_ 
I 

- -;-··-

J Setting 

1 Enable course request l No 
; Default category for course-- Miscellaneous 
. requests 
r Course request notification I Nobody - . ·- ~--_-[-__ _ 

i 
: 

J 

I 
Anne Thorp, PhD athorp@oaisd.org September 2011 1 
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Backups> General backup defaults 

Feature Default 
Include users Yes 

Anonymise information No 

· Include role assignments Yes 

I Include user files , Yes 
I 

Include activities Yes 

Include blocks Yes 

' Include filters Yes 

Include comments , Yes 

, Include user completion Yes 
information 
Include log I No 

Include histories No 

Backups> Automated backup setup 

· Feature 1 Default 
Active 1 Disabled 
Schedule -1 None 

1 Execute at 0:0 
Automated backup storage I Course backup file area 
Save to Empty 
Keep I 1 
Users · Yes 

; Include users 
I Include role assignments 

Include user files 
Include activities 

1 Include blocks 
! Include filters -
: Include comments 
I Include user completion 
1 information ~ __ 
' Include logs 
1 Include histories 

· Yes 
I 

Yes 
·- I Yes 

Yes 
-I 

I Yes _j 
Yes 

1 Yes 
Yes 

J No 
No 

Setting 

t 
1 -
I 

I 

- _J_ 
-+ 
I 

1 Setting 

- I 

r 

-- ~-
_J 

I ,_ 

-~ 

l 
_j 

1 
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General settings 

1 Feature . Default ------- Setting 

; User profile report ; User report 
! Graded role Student -· -- l-

Aggregation position Last 
Include scales in aggregation ; Yes 

· Show submitted grades for No 
! hidden grades 

Enable publishing No 
Grade export display type Real 

; Grade export decimal points 2 
· Navigation method 
Primary grade export 
Unlimited grades 

I Dropdown menus 
- I 

None 
No 

Grade category settings 

Feature : Default 

1 

--------
1 Hide forced settings Yes 

Aggregation 
1 
All 

I -
Aggregate only non-empty Yes/advanced 

I cells 

- t 
--- j 

I Include mttcomes in No/advanced 
aggregation 

I Aggregate including No/advanced 
, subcategories 

Keep the highest None/force/advanced 

; Drop the lowest None/advanced 

Setting 

Grade item settings 

I Feature 
[ Grade display type 

Default I Setting 

, Overall decimal points 
Advanced grade item 

, options 

~eal _____ -=-L_ __ ~--
Item info, ID number, Grade 
to pass, Offset, Multiplicator, 

· Grade display type 

Anne Thorp, PhD athorp@oaisd . org September 2011 
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[ 

Scales 
. This allows you to create custom scales that can be accessed from any course on your server. 

Scale name Values (lowest to highest) 
1 Separate and connected ways of knowing Mostly separate knowing, Separate and 

connected, Mostly connected knowing 

I 

Letters 
This allows you to open the standard letter assignments default for the site. Any changes you 
make here will become the default for the numerical letter grade conversions for your site. 

' Feature 
Grade letter 1 
Grade letter 2 
Grade letter 3 

' Grade letter 4 
Grade letter 5 
Grade letter 6 
Grade letter 7 

' Grade letter 8 
' Grade letter 9 
I Grade letter 10 
~ Grade letter 11 

Default 
A: Boundary: >93.00 

1 A-: Boundary: >89.00 
B+: Boundary: >87 .00 

I B: Boundary: >83.00 
B-: Boundary: >80.00 

1 C+: Boundary: >77.00 
C: Boundary: >73.00 
C-: Boundary: >70.00 
D+: Boundary: >67 .00 

i D: Boundary: >60.00 
F: Boundary: >0 

Report settings> Grader report 

' Feature : Default 
; Students per page 

i Quick grading 

1 Quick feedback 

! Static students ~olumn 
I 

1 Grades selected for column 
1 averages 
1 Enable AJAX 
I 

1 Show calculations 

' Show show/hide icons 
I 
Show column averages 

I 100 
I 
I Yes 

No 

No 

Non-empty grades 

· t No 
I 

No 

I No 

Yes 

Setting 

t· 

Setting 

' 
!• 

j 
' I 
1 

~ 
l 

Ann e Thorp , P h D athorp @oa i s d . org S e pt em b e r 2 011 Page 20 



Show locks 

1 
Show ranges 

I -

Show user profile images 
I 

Show user ID numbers 

Show activity icons 

: Show number of grades in 
I 

: averages 
Column averages display 

1 type 

No 

. No 

1 Y~s 
No 

1 Inh . 
1 ent 

' Range display type I Inherit 

! Decimals in column av;rages 1 Inherit 
- I 

' Decimals shown in ranges Inherit 

Report settings> Overview report 

Feature Default 
Show rank 

; Hide totals if they contain 
, hidden activities 

No 

i Hide 

Report settings> User report 

1 Feature 1 Default 

I 
- -~ 

; 

t 
r 

Setting 

--------I 

1 Setting 
Show rank No 

1 
Show percentages No 

I Show grades Yes 

, Show feedback Yes 

Show ranges Yes 

Show weightings I No 

I Show average No 
I 
' Show letter grades No 
1 Range decimal points 0 
f l No : Show hidden items 

: Hide totals if they contain Hide 
I 

I hidden items _j_~ 
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[ 

Location 

Location >Location settings 
1 Feature Default 
· Default time zone 

· Force default time zone 
i . 
1 Default country 

Default city 

GEOiP city data file 
I 

Google Maps API key 

All country codes 

I Server' s local time 

' Users can choose their own 
I time zone 

Choose 

I Type in choice 
I 

url/geoip/GeoLiteCity.dat 

Empty 

· Empty 

Location >Update time zones 
Select Continue to load or update the region/city time zone list 

Language 

Language> settings 

Feature Default 
Language auto detect Yes 

Default language English (en) 

1 Display language menu Yes 

' Languages on language ; Empty 
I menu _ I 

I Cache language menu 
I 

Yes 

1 Cache all language strings 1 Yes 
I 

1 Site wide locale ; Empty 
I 

j Unicode , Excel encoding 

: Setting 

~ 
I -
l-

Setting 

-L 
I 
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Language >Language packs 
This page allows you to select language packs to add to your Moodie site. 

List any language packs that you have added to your server. Note that the parent pack is 
English_ US and remains in all language options. 

Language> Customization 
This area will allow you to modify the standard Moodie text strings if you like. Normal Moodie 
upgrades do not generally override these changes, however, you may want to make note of any 
changes you make. 

Moodie term Local term 

J 
I 
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lug in~ 
Activity modules> Manage activities 

This area will display all of the loaded activities and resources modules on your site. From here 
you have the opportunity to hide the activity from users . 

Blocks> Manage blocks 

This area will display all of the loaded blocks loaded on your server. From here you can hide the 
block from users, and set the default options for some blocks. 

Authentication >Manage authentication 

This area lists all of the authentication methods on your server. 

Available Authentication Plugins 

' Authentication plugin · Default 
· Manual accounts 1 Enabled 

No login J Enabled . 

, Email-based self-registration 1 Enabled 

' CAS server I Disabled 

I External database 

I First class server 

1 IMAP server 

LDAP server 
I . 

1 MNET authentication 
I 

; NNTP server 

l No auth~ntication 
PAM (Pluggable 

! Authentication Modules) 

1 POP3 server 

RADIUS server 

Shibboleth 

1 Disabled 

: Disabled 

Disabled 

I Disabled 

. Disabled 
- ..J 

; Disabled 
• 
; Disabled 

f Disabled 
! 

1 Disabled 

! Disabled 

i Disabled 
-

: Web services authentication ! Disabled 

---- -· -

The changes you make here will be saved automatically. 

Setting 
Cannot be disabled 

1 Cannot be disabled 

I 
I 

f 

J 
I 
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Common Settings 

Feature Default 1 Setting 
: Self-registration Disable I Guest login button 1 Show 

I I . 
: Alternate login URL Empty 

1 Forgotten password URL l Empty 
I 
· Instructions Empty 

Allowed email domains 1 Empty 

! Denied email domains Empty 
I 
; Restrict domains when J Yes 
1 changing email I 
! ReCAPTCHA public key Empty 

j ReCAPTCHA private key ' Empty 

Plugins >Authentication> Manual log ins 
You can lock user data fields. This is useful for sites where the user data is maintained by the 
administrators manually by editing user records or uploading using the 'Upload users' facility. If 
you are locking fields that are required by Moodie, make sure that you provide that data when 
creating user accounts or the accounts will be unusable. 

Enrollments> Manage enroll plugins 
Available Course Enrollment Plugins 

Enrollment plugin Default -------
: Manual enrollments Enabled 

: Guest access l Enabled 

Self-enrollment Enabled 

Cohort sync Disabled 

1 Category enrollments Disabled 

' External database Disabled 

Flat file (CSV) I Disabled 
l 

IMS Enterprise file 1 Disabled 

I LDAP Enrollments 1 Disabled 
1 Disabled 

1 
-=-~~-1 

Setting 

I 

--l 

; Course meta link 
I 

: l\1NET remote enrollments Disabled 
I -

1 Disabled ' PayPal 
- .. ~ 1- ~-=-_-----·----1 
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Text ed itors > Manage editors 

. Text editors plugin Default 
i TinyMCE HTML editor I Enabled 
: Plain text area I Enabled 

Licenses> Manage licenses 
Default site license: All rights reserved 

; Available licenses i' Default 
plugin 

' ----------; Other Enabled 
I . ·-
' All rights reserved 

; Public domain 

i Creative Commons 

l Creative Commons -
! NoDerivs 

1 Enabled 
1 Enabled 

' Enabled 

Enabled 

, Creative Commons- No 
: Commercial NoDerivs 

Enabled 

Creative Commons- No 
1 Commercial 

, Enabled 

: Creative Commons- No 
~ Commercial ShareAlike 

: Enabled 
; 

· Creative Commons -
Share Alike 

Enabled 

Filters> Manage Filters 

' Filter ! Active? 

Multimedia t On 
I plugins Enable .mp3 filter 

Enable .swf filter 

Enable .mov filter I 
I 

Enable .wmv filter 

Enable .mpg filter 

Enable .avi filter 

Enable .flv filter 

Enable .ram filter 

Enable .rpm f ilter 

Enable .rm filter 

Enable YouTube 
links filter 

Enable .ogg filter 

I Setting 

j Apply 
J to /Default 
I Content 

I Yes 

No 

Yes 

Yes 

Yes 

Yes 

Yes 

Yes 

Yes 

Yes 

Yes 

J Setting I 
~-~--'-1 ___ J 

I 
I 
I 
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Enable .ogv filter 
Enable .auto­
embedding of 
linked images 

Display emoticons · Disabled 
~------------~ 

as images Apply to formats 

I 
TeX Notation Disabled 

LaTex preamble 
Transparent color 

Density 
Path of latex binary 
Path of dvips binary 

Path of convert 
binary 
Convert output 
format 

Activity Name 1 Disabled 
I auto-linking I 

; Algebra Notation Disabled 

Database auto- I Disabled 
linking I 

1 

Em~il protection 1 Disabled 

Glossary Auto- I Disabled 

1 
linking 
HTMLTidy Disabled 

Disabled 1 Multi-Language 
I 

1 I Filter multilang_force old I 1 content 
l Wiki Auto- , Disabled 
· Linking I 

' ! Word ce.;sorship 
1 

Disabled 

I I Custom bad words list 
Convert URLs Disabled 

i into lin~ __ I A~~~~ to formats 

.1 - - -- ·-

Yes 

Yes 

Content 
Moodie auto­
format, HTML 
format, 
Markdown format 

Content 
Default settings 
#FFFFFF 

120 
/sw/bin/latex 
/sw/bin/dvips 
/sw/bin/convert 

GIF 

Content 

Content 

Content 

1 Content 
I 

l Content 

Content 

Content 
I No 
Content 

Content 

I Em~t~ 
Content 
Moodie auto-
format 

. I 
I 
I 
! ·-

I 
I 
I 

I; 
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Filters> Common filter settings 

I Feature ] Default Setting 
1 Text cache lifetime I I minutes 

~ . ' 
, Filter upload files ; None I 1 

I : Filter match once per page No 

Filter match once per text j No . -I 

Repositories> Manage Repositories 

j Active 
I 

1 Repository ; Setting I 

! Server files 1 Enabled and visible 

_, 
i -·-' ' Upload a file ! Enabled and visible I 

I 

· Recent files Enabled and visible I 
Private files 1 Enabled and visible 

I I 

1 Alfresco Repository I Disabled 

: Box.net : Disabled 

J Legacy course files Disabled 

i Dropbox ; Disabled I 

1-I File system Disabled 
I • 

i Disabled ; Fhckr I -
1 Flickr public 1 Disabled 

Google Docs i Disabled 

; Merlot.org Disabled 

. Picassa web album 
- I 

Disabled 

1 Amazon S3 . Disabled 
I I . 

I URL Downloader 1 Disabled I 

I I 

l , WebDAV repository I Dis.abled -T 
I - . 

: Disabled 
!- - ---

! Wikimedia l 
[ YouTube Disabled 

--i ~-
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• ~ . ..... 1'\11 , 
1, I • I .. 

This is where you manage the types of questions available for course developers to use. Some of 
the question types are dependent upon other question types. 

l Question Type l Available I Setting 
I Calculated 1 Yes 

J 
i .... __ ---
1 Calculated simple : Yes 

-
1 Calculated multi-choice Yes I 
1 De~ription ---- --; 

1 Yes 

' 1 Embedded answers (Cloze) I Yes I 

---! I Essay 1 Yes 

-1-
-- - l 

Matching Yes 

1 Multiple choice I Yes 

Numerical Yes 

. Random · Yes 
I 

I _, 
Random short-answer 

1 matching 
Short answer 

True/False 

IP Blocker 

Feature 
· Allowed list will be 
1 processed first 
· Allowed IP list 

Blocked IP list 

Yes 

1 Yes 

Yes 

Scru rity 

Default ------- Setting 
No 

Empty 
-

Empty 
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Site Policies 

Feature 1 Default 
--~ 

Setting 

1 
Protect usernames Yes 

1 Force users to log in I No 
' I I --- -. 

I I Force users to login for I Yes 
1 profiles - I I Open to Google _ -

-.-, 
1 No I i 

I Profile visible roles Teacher, Non-editing teacher, I 
I Student 

Maximum upload file size T Server limit 

User quota 104857600 

Enable HTML Purifier Yes 

Allow EMBED and No 
-t 

OBJECT tags 
Enable trusted content No 

, Maximum time to edit posts 30 minutes 

' Full name format · Language 

Allow extended characters I No 
in usernames 

· Site policy URL Empty 
1 

Site policy URL for guests Empty 

Keep tag name casing Yes 

Profile for enrolled users Yes 
only 
Cron execution via ! No 

, command line only 
I Cron password for remote Blank 

I 1 access 
I Password poli~y I Yes 1 

- ·-Default policy ' Length = 8 

1 Digits= 1 
I Lowercase letters = 1 

Uppercase letters= 1 
: Non-alphanumeric characters 

=1 
Consecutive identical 
characters = 0 

1 Group enrollment key policy Yes I 

I 
· Disable user profile images · Yes 

-1 

I 
1 Email change confirmation 

1 
Yes I -

i I ! 
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HTIP Security 
: Feature 1 Default 1 Setting 
! Use HTTPS for logins No I -- -
1 Secure cookies only No l ------

Only http cookies No 
I 

-~ -·- 1 
I Require flash player version 10.0.12 I 

Module Security 

: Feature Default 1 Setting 0 l 
: Restrict modules for No courses _J 
I Restrict modules by default I No 

t 
I l I ... 

: Default allowed modules None I 

- - -- ! 

Notifications 

Feature Default Setting 
· Display login failures to I Nobody 

l Email login failures to l Nobody _ 
I ~ 
1 Threshold for email 110 
I 

notifications 
· Use clam A V on uploaded No 

-i 

files ----
Clam AVpath Empty 

-~ 
I . 

: Quarantine directory ! Empty 
I 

1 
On clam A V failure . Treat files as OK 
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Themes >Theme settings 

I Feature Default ; Setting --·-
1 
Theme list Empty 

• 
1 Theme designer mode i No 

I 
I 
j 

Allow user themes No I 
Allow course themes No r 

1 Allow category themes No 
Allow theme changes in the No 
URL 
Allow users to hide blocks Yes 

· Custom menu items Empty 

Themes > Theme selector 

' Feature [ Default --- 1 Setting 
Anomaly · No 

Arialist I Yes 

: Binarius No 
1 Boxxie No 
1 Brick Yes 

' Formal white I Yes 

1 
Formfactor No 

- -r-
1 Fusion Yes I 

1 Leatherbound No t l 

l Magazine I Yes 
- I 

I 
I .•. I 

I Nonzero Yes 
- -1 

---·-- -
! Yes ' Overlay 

I l -
r 

i Serenity No 
Sky High I Yes _1 

I Splash Yes I 

~ Standard i No ----t-
' ~- -
1 Standard (Legacy) No 1 
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i 
I 
I . 
L 

Custom Theme Development 

If you are using an externally created theme, record the details here. 

Theme Options 

Themes may be customized at the CSS file level. Some allow customization via the Moodie 
Admin interface. Here are the standard themes and their options. 

Aria list 

1 Feature 
Logo 
Tagline 
Link color 
Column width 

I 
, Custom CSS 
'· 

Brick 

; Feature 
! Logo 

I Link 
1 Linkhover 

; Maincolor 

Maincolorlink 

Heading color 

Formal White 

I 

Default 
Empty 
Empty 

' #f25fof 
I 250px 
' Empty 

I 

1 Default 
· Empty 
1 #06365b 
j 

#5487ad 

l #8e2800 

#fffoa5 
1 

1 ~5c~500 

: Setting 

~ 
I 

l' 
_j_ 

------·1 Setting 

t-
-t 
I 
1 ·-- ------

1 
- - ~- - -- ---1- --

Feature I Default - ----- ~ Setting 
Blocks background color 

1 
#F7F6Fl __ -1= 

Logo __ J Empty__ __ ------
Column width 200px 

, Display lang~agi menu - 1 No --- j_ -

I 
I 
I 

.I 
I 

. ~ -·~ 
-- _.J 

_ _I 
-:=__-j 

I _, 
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[ Footnote -
1 

No 

Custom CSS I Empty _, 

Fusion 
: Feature l Default i Setting I 

I 
.j 

~ Link color l #2d83d5 
I - • t 
: Tagline 1 Empty I 

-
1 Footertext , Empty 

Custom CSS 1 empty . 

Magazine 

I Default i Setting 
1 

' Feature i 

I Background 
I 

Empty l 

I 1 Logo : Empty 

' Link · #32529a 
1 

Linkhover · #4e2300 
' ' 

i Maincolor #002f2f i 

. Maincoloraccent : #092323 t 
I 

Headingcolor #4e0000 
1 I . 

1 Blockcolor : #002f2f I 

I ' _, 
Forum back · #FCFDC6 ! 

l -

Nonzero 

; Feature j Default 1 Setting 
I 
I 

- - ~ 
; Left column width 1 200px j 
, Right column width i 200px 
1 Column width 

I 

• 200px 
--- 1 I - - I • --

Custom CSS i empty I 
I __ l - - - -

Overlay 

Feature ; Default I Setting 
Link color · #428ab5 

-=~ 
- - ... _ ... . 

Header color 1 #2a4c7b _J - - - - I - ----- __ .. --
Footertext Empty I 

_I Custom CSS ! Empty 

[ ___ A n n e T h o r p , P h 0 a t h o r p @ o a i s d . o r g S e p t e m b e r Page 34 



Sky High 

I 
Feature 

. Logo 

I Default 
1 Empty 

j Setting 

I . 

I Column ~idt~ 1 240px 
- ., ... .. -

I 

: Footnote 1 Empty 
i -

: Custom CSS 1 Empty 

Splash 

~ Feature 
Logo 

' Tagline 

I Hide tagline 
I 

Footnote 

------ ~ Default 
1 Empty 

: Virtual learning center 
l - - . 

No 

I Cust~m CSS 

j Empty 

1 Empty 
I 

I Default 

l 

. J . ... - -

-·1-
l 

I setting 

Calendar 

Feature 
Admins see all 

-------- I Setting 

: Time display format 

! Start of week 

No 
~ 

~ Default 

1 
Sunday 

1 Weekend days - - ·1 S~nday, S~tu;day 
j - -

j Days to look ahead 

1 Events to look ahead 

21 . 
1 10 -

I . 
1 Enable calendar exports ' Yes . . . 

: Calendar export salt : Random text string 

Blog 

· Feature I Default 

- t 
I 
l 

-1--

-l 

f Enable blog associations -----·--- ~ Setting 

' Yes 
I - ·1·· - -. - •• 
! Blog visibility 

1 
All site users can see all blog 

- ' 

I 
• I 

_ J 

. - ' 
j 

J 

j 
. J 

I 1 entries 
I Enable ·;xternal blogs ~ ~ Yes ~ ---- ____ =l 
f External blo~ cron sch~~~l~ _! 24_ hours_ __ _ _ 

J Maximum number of 'j l 
I external blogs per user _ _ ---- --------1-
j E~able comments _ _ I Yes j _ 

--- I 
----~---
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' Show comments count Yes 

Navigation 

Feature Default ------- ' Setting 
1 Default home page for users Site 
I 

· Show course categories ! Yes 
--- t 

! Show all courses 
1 Course limit 

HTML Settings 

Feature 

No 

20 

Default 
Remove HTML tags from all Yes 
activity names 
Emoticons 1 Emoticons definition table 

Moodie Docs 

: Feature 1 Default 
Moodie Docs document root http://docs.mooule.org 

-
Open in a new window No 

.~, •• t J\,., f\A, " .-1 1-1 p. ~· 

Setting 

Setting 

Allows you to set the design of the My Moodie page if you'd like 

~. I .. 1 ... -

Allows you to set the default design of the Profile page 

Course Contacts 

I Feature j Default , Setting 
' Course contacts Teacher 

~ --~--

AJAX and Javascript 

Feature , Default -- . Setting 
i Enable AJAX Yes 

Use online YUI libraries I No 
J 

YUI combo loading Yes 

Anne T horp , PhD atho r p@oaisd . org September 2011 Page 36 

- I 

• f 
I 

tjacobso
Typewritten Text
Default My Moodle Page

tjacobso
Typewritten Text
Default profile page



I Cache Javascript J Yes 

Enable AJAX course editing Yes 

Manage Tags 

Feature 1 Default -------

J ·--­L_ 

1 Setting 
Add official tag 

I 

i With selected tags 

. Blank 
1 ----

Functions 
• Reset flag 

---~-t 
• Delete 
• Change tag type 
• Change tag name 

I 

I 

Additional HTML 

Feature I Default I Setting 
' Within HEAD Empty 

When BODY is opened Empty t 
I 

Before BODY is deleted Empty 

-·-J 
I 
I 

I 
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Front Page 

Front page settings 

Feature Default Setting 

1 Full site name Default is set at time of install 
1 Short name for site 1 Default is set at time of install 

J . 

' Front page description 1 Default is set at time of install 
I 

.. 

. Front page None X 4 slots I 
A vail able options 

. 
I • News items 

• List of courses 

• List of categories 

• Combo list 

• None 
Front page items when None X 4 slots 

; logged in Available options 

• News items 

• List of courses 

• List of categories 

• Combo list 

• None 

1 Maximum category depth Unlimited 
Include a topic section No 
News items to show 3 

1 . 

Include a topic section No 
Comments displayed per 15 

; page 
Courses per page 20 
Default frontpage role None 

Front page roles 

I Feature ___ 1 Default , Setting I - ··~ I Front page roles I • Manager 

• Teacher 

• Non-editing teacher 

• Student 

Front page filters 
Allows you to turn on or off available filters for front page context 
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Backup Setting 

~ Feature 
I 

I Include enrolled users 

; Anonymize user information 

1 Include user role 

1 Default --------
1 Yes __ _ 

No 

Yes 
I 

r 
assignments 

--- r. . 
, Include user files 

! Include activities 
I . 
I Include blocks 
I 

I Include filters 

1 Include comments 

Include user completion 
data 

I Include cou~se logs 

f Include grade history 

Front Page Restore 

1 Yes 

Yes 

; Yes. 

1 Yes 

Yes 

Yes 

No 

i Setting 

+ 
I 

Allows you to restore the front page from backup file created from the Settings > Front 
page settings> Backup 

Front-page Questions 
Access the question bank to set up or manage front page questions 
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System Paths 
· Feature 
; GD version 

Path to du 

! Path to aspell 

Path to dot 

Email 
Feature 
SMTPhosts 

SMTP username 

, SMTP password 

I SMTP session limit 

I No-reply address 
I 
1 Hour to send d igest emails 

Character set 

· Default 
! GD 2.x is installed 

l Empty _ -· 
Empty 

I empty 

Default 
Empty 

' Empty 
I 

Empty 

1 

I noreply@ localhost 

!17 
I UTF-8 

, Allow user to select I No 
. character set 
1 Newline characters in mail LF 

· Support name -Admin-

' 1 Support email admin @nomail.xy 

1 Support page empty 

Jabber 

~ Feature 
i Jabber host 

: Jabber server 

: Jabber user name 

! Jabber password 

Jabber port 

1 Default 
Empty 

1 Empty 

Empty 

Empty 

5222 

, Setting 

.l 

Setting 

f 

: Setting 

L. 
I 
I 
~ 

----1 
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Session Handling 

~ Feature 
Use data base for session 

1 information 

1 
Timeout 

I Cookie prefix 

i Cookie path 
I 

1 
Cookie domain 

·-- --

HTTP 

Feature 
Frame name 

1 Use slash arguments 

I 
Reverse proxy/logged IP 
source 

I 
Web proxy/proxy host 

Proxy port 

Proxy type 

, Proxy username 
I 

· Proxy password 

· Proxy bypass hosts 

M aintenance M ode 

, Feature 
Maintenance mode 

, Optional maintenance 
I message 

Cleanup 

1 Feature 
I 

: Delete not fully set up users 
I after 
Delete incomplete users 
after -
Log guest access 

Keep logs for 

1 Disable grade history 

1 Default Setting 
1 Yes 

· 2 hours 

M20 
{ I I 

_ j 

Empty 

: Default . Setting 
_top 

l : Yes 
I· 

HTTP _CLIENT_IP, 
HTTP _X_FORW ARDED _FOR, 
REMOTE_ADDR 

I Empty 
J . 

0 

HTTP 

t-
i- -l 
1 I - - ~ 

Default , Setting 
Disable 

l Empty 

I Default ---------------- Setting 
7 days 

Never 
I 

J 
Yes 

I Never delete logs 

I No 
' 

-i 
t 
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Grade history lifetime Never delete grade history 

'. t 

Allows admin to perform server check for php extensions and database compatibility for 
the current and future versions of Moodie. 

) ~ J.J l {l · t 

Displays all PHP settings on the server. You cannot make any changes on this page. 

Performance 
Feature 
Extra PHP memory limit 

cURL cache TTL 

Reports 
Report 
Comments 

: Backups 
Config changes 

Course overview 

1 Logs 
I 

' ' I 
I 

: Live logs 
1 Question instances 

I . . 
' Secunty overview 
I 

Default 
128M 

120 seconds 

Description 

Setting 

View/delete comments that have been made in any context 
l Report on internal automated backups 

I . I 

List change log for all site configuration settings that have been 
1 modified 

Requires statistics to be enabled. Report will show statistical 
analysis of 

• Most active courses 
• Most active courses (weighted) 
• Most participatory courses (enrollments) 
• Most participatory courses (view/posts) 

1 within a given date period 
Show a sortable course logs by 

• Course 
• Participant 
• Date 
• Activity 
• Actions 

' Report may be displayed, downloaded in text, ODS, or Excel 
format -

1 Display actions on the server in real time 
Creates a list of all courses that contain questions of a particular 
type 

' Returns systems check of all kn~wn security risks, site settings, 
I and reports the current status and description - "' 
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Spam cleaner 

Statistics 

- -
Allows you to search all user profiles for custom key words or 
common spam patterns 

1 Allows you to view a graph of ~ser activity ~ov~r a period of 
, time 

DevPloprnP nl 

Experimental> Experimental settings 

: Feature ; Default 
L • ------------

Enable global search 

1 Enable safe exam browser 
integration 

1 
Enable group members only 

: No 

: No 
' ! 

No 

Experimental > Database transfer 

I Feature ; Default 
r Type 1 Mysqli/native 

, Host server : Blank 
' I 

; Database Blank 

Setting 

, Setting 
I 

1 

I 
-1 

j 
I : User 1 Blank 

t 
I . 

Blank -~- j 
Password 

I 

1 ; Tables index : Blank 

Experimental >Database export 

· Feature I Default 
l D . t• . Blank -----------i escnp Ion 

Setting 

Debug message I Non~: d_~ not show any errors ;-
l or warnmgs . _ _ -~--

Display debug messages 
I 
I . - --
. XML strict headers 
: Debug mail sending 

J No 
] No 

I No 
; Performance info ____ 1 No 

1 Show origin of language 
1 

No 
t strings _ 

Show validator links I No 
I 

I - - -
Show page information 

L - - -
, No 
I 

I 
- --·-~-

~-- -
I 

--- - ~-

- -4-------
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XM 1.0 II Pd ito f' 

The XMLDB editor is a tool for making the .xml files that specify how Moodle should 
set up its database tables. 

Web Service Test Client 

' Feature 
; Authentication method 

Protocol 

1 Function 

Purge All Caches 

Default 
Simple 

Blank 

Add_group_add_groupmembers 

Setting 

Moodie can cache themes, javascript, language strings, filtered text, rss feeds , and many 
other calculated data. Purging these caches will delete that data from the server and force 
browsers to refetch data, so that you can be sure you are seeing the most up to date values 
produced by the current code. There is no danger in purging caches, but your site may run 
a bit slower for a while until the server and clients calculate new information and cache 
it. 

Unit Tests 

1 Feature 
, Show passes as well as fails 

i Show the search for test 
files 
Only run tests in 

Functional DB Tests 

Feature 

Default 
No 

I No 
I 

Blank 

Setting 

: Setting I 
I 

, Show passes as well as fails 

1 Default 
No -~ 

I 
1 Databases 

-
1 Yes: Current database 
I 
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Moodie Resources 

MI Moodie Users Listsserv 
• This is a MI Moodie user community 
• Post questions 
• Answer others 
• It's free! 
• https://lists.remcl.net/mailman/listinfo/mmu to register 

Moodie training videos 
• Virtual Moodie Archives 

o http://moodlinthrough. wikispaces.cornl 
• Moodie Tutorials 

o https:/ /moodle.sandi.net/course/view. php? id= 1192 
• Using Moodie: Teachers' first course (more videos for you to steal) 

o http://www.inanonymity.org/alexsalinskyl?p=144 

Free Using Moodie Book 
• http://moodle.org/mod/data!Yiew.php?d=55&rid=1940 

Moodie 2.1 Release notes 
• What's happening in Moodie 2.1? 

o http://docs.moodle.org/dev/Moodle 2.1 release notes 
Getting started for teachers 

• http://docs.moodle.org/20/en/Getting started for teachers 
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Moodie 2 .1 + Site Administration by Anne Thorp, PhD OAISD is licensed under a Creative Commons 
Attribution-NonCommercial 3.0 Unported L1cense. 

r 

This Moodie handbook is loosely based on information gained through Remote-Learner Moodie 
2 orientation. http://remote-leamer.com 
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